
Content 
Work space

Draw 

Modify

Layer

Annotation 

Block

Property

Utilities

Clip board

View

Insert reference

Area calculation

Cutting sections

Plot

Import and export 

This Tutorial is formatted mainly for AutoCAD 2010/2011 2D Drafting & Annotation Mode. 

Important tools/commands are highlighted in red bold. 

Words in parenthesis are type-in commands.

AutoCAD Tutorials



enter commands for drafting and other functions here (recommended way to draw 
because it is faster than clicking iron) This line will also show options within a tool. 
Please make a habit to constantly check the command line for what you can do with 
the tool you selected.

If you are used to the workspace in older 
version, you can choose “AutoCAD Classic” 

Tabs

Panels

workspace

When Tabs or Panels disappear sometime, you can right-clicking on the grey part of the menu bar to fi nd them. 



save

When you open AutoCAD, there is an existing sheet called “Drawing1.dwg”. You can work on this sheet and then 
save it by either of these two ways. 

After the fi rst time save, you can click this button 
or use shortcut Ctrl+S to save your drawing. It 
is a good habit to save your work frequently in 
case the software crashes or power off.

The drawing is saved as AutoCAD 2010 
Drawing as default. If you want to open it in 
other softwares(like Sketch Up, Rhino) or lower 
version AutoCAD, you have to save it as a lower 
version. 



set up a new sheet

There are two ways to set up a new sheet

The default format is “acad.dwt”. In practice fi eld, 
you may be required to use a template.



basic operation

drawing units (units)

select / deselect

general shortcuts

cursors

not in command in drawing command in modifying command

Settings and management

You can set the drawing units in Tools > Units.  As a default, the 
measurements in the drawing is unitless.  For example, when you draw 
a line with length “10”, AutoCAD doesn’t know if it is 10 miles or 10 
millimeters until you set the unit.  Remember to set it before you start 
drawing, or scale the drawn objects accordingly if you change the unit in 
the existing drawing.

Architectural (i.e. 1’-3 1/2”) and engineering (i.e. 1’-3.50”) units are most 
frequently used in the states.  Please note that you have to specify the 
type of units in Insertion Scale tab when it is set to decimal, scientifi c, or 
fractional units. 

For example, if you want to use millimeter:
set “Type” in Length window to Decimal > set Insertion Scale to Millimeter

You can select the objects by clicking on an object or drawing a window around it.  Drawing a window from 
left to right selects everything that the window crosses.  Drawing a window from right to left selects 
everything that the window contains. You can deselect objects by doing the same operation while holding 
down Shift key, or deselect everything by hitting Esc key.

When you are not in command, the cursor looks 
like a cross with a square in the middle.  When 
you are in drawing-related commands, the square 
disappear.  When you are in modify-related 
commands, only the cross disappear.  You can 
escape from a command by hitting Esc key.

Many general shortcuts are used in AutoCAD.  

For example:
Ctrl+S saves the dwg fi le (qsave)
Ctrl+Z undoes the previous action (u) and Ctrl +Y redose the undone action again (redo)
Ctrl+C copies and Ctrl+V pastes
Ctrl+P opens the plot window (plot)



snap & tracking

There are settings that help you draw accurately. Please pay attention to the tabs below the command line and 
click on them to turn on/off.

Snap Mode: snaps to increments of the spacing that you specify. (i.e. if you set it to 2 in both x,y direction, 
it will snap on 2,2:2,4:10,8 etc)

Grid Display: displays grids with the spacing that you specify

Ortho Mode: restricts movements to horizontal and vertical directions. 

Polar Tracking: tracks increments of the angle that you specify(i.e. if you set it to 30 degrees, it will track 
30,60,90,120 degrees etc.)

Object Snap: snaps to existing objects on the screen. You can also activate specifi c Object Snap during 
drawing/inquiry operations by right clicking and selecting snap overrides.

Show/Hide Lineweight: turns on/off the line width on display.It does not affect the line widths on plot.

Quick Properties: displays the properties of selected object(s). Another way to show properties: After 
select a object/objects, right click and select “Quick Properties”. You can change the object(s) properties 
here(layers,color and linetype.)

snap overrides right click quick properties



If you type “a” while drawing a polyline, your next segment will be 
an arc.  It will continue to draw arc segments with tangent to the 
previous arc.

LINE (l): draws a line from one point to another.

POLYLINE (pl): draws a line/curve with multiple
control points. 

Pay attention to the command line while using 
POLYLINE tool; it will show you variety of options 
for the next move you can take.  Following are 
some of the examples.

drawing a polyline

hitting Esc

typing “cl”

If you hit “Esc” while drawing a polyline, the line terminates at the 
last point you clicked.

If you type “cl” while drawing a polyline, it draws a segment that 
connects the starting point and the last point you clicked (the line 
becomes a closed shape).

You can also draw an object with arcs using POLYLINE tool.

line

polyline

Draw

There are two ways to draw

1. type full or short name in command line(increase effi ciency)

2. Icon: Home/Draw

short name
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If you type “s” while drawing an arc segment, you can defi ne an arc 
angle by specifying three points that the arc goes through.

If you type “r” while drawing an arc segment, you can defi ne an arc 
radius.

RECTANGLE (rec): draws arectangle by defi ning two corners.

If you type “@” after defi ning the fi rst corner, you can specify the 
second corner by x,y coordination.  For example, type @36,24 for 
36” x 24” box.

If you type “d” after the fi rst corner, you can specify the second 
corner by the x and y distance from the fi rst corner. For example, 
type “d” > space > 36 > space > 24 for 36” x 24” box.

Click on the point where you want to place the fi rst corner of a 
rectangle or type in x,y coordination for precise imput.

POLYGON: draws a polygon by number of edges.

If you choose to inscribe in circle, it draws a polygon inside the 
circle with the radius you specify.

If you choose to circumscribe about circle, it draws a polygon that 
contains the circle with the radius you specify.



CIRCLE (c): draws a circle.

First click will defi ne center of the circle.  defi ne the radius by 
typing it in or clicking.

If you type “d” after the fi rst click, it will draw a circle with the 
diameter that you specify.

If you type “2p” or “3p” before clicking the center, it will draw a 
circle that goes through the points you specify.

SPLINE (spline): draws a spline connecting multiple points.

Defi ne the points that a spline goes thgough by clicking.

End the tool by hitting Esc (terminates the spline at the last point 
clicked) or typing “cl” (adds a curve back to the starting point).

Spline has a tendency to increase the fi le size and may cause 
complecation when modify later.  Excessive use of splines are 
not recommended especially when sharing a fi le with other 
people.



Type: usually predefi ned

Pattern: choose the pattern from list (pull 
down) or clicking either of these.

The window below pops up. ISO has basic 
patterns. Other predefi ned tab shows com-
monly used patterns such as BRICK, EARTH, 
GRAVEL, CONC, SAND...  

You can modify the angle and scale of patterns

When hatching a complete object, such as 
circle, rectangle, or polygon, select “Add select 
object”. If you wish, you can pick multiple ob-
jects at one time.

When hatching a space defi ned by different ob-
jects such as an overlapped zone of 2 circles, 
select “Add Pick points”. The more complex the 
area is the longer it takes to calculate.   You 
get an error message when the area is too 
complicated to calculate.  Zooming in/out to the 
hatching area sometimes helps.  You can also 
maunally manipulate the selection areas by 
using buttons below: “remove boundaries” and 
“recreate boundaries”

Check “Associative” if there 
is a possibility that the shape of 
the hatch may be modifi ed later.

You can copy/paste the exact 
hatch properties from existing 
hatches by clicking this. 

Once the selections are set, let’s check how it looks by clicking “preview” button on the left corner. Modify 
angle and scale if necessary.

You can also modify the property after you complete the command. Double click the hatch and the property 
window will pop up. Simply make changes.

HATCH(h): fi lls an enclosed area or selected objects with a hatch pattern or fi lls.
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You can directly place blocks by specifying a block instead of #s.

Divide or measure, select the object, (b) for block, type the name of block (must be exact name), defi ne 
if you want the block to align the curves or not, enter # of segments or length of segments.

Do not forget to place blocks at the ends.

This may be useful for placing plants, light, etc...

DIVIDE (div): Divide an object into certain length or perimeter segment. You can draw from the node or you 
can place objects along the nodes. i.e. You want to place 5 trees equally on a line.

Select object to divide, enter # of segments.

MEASURE (me): Places point objects or blocks at measured intervals on an object. i.e. You want to place 
trees every 50 feet. 

As default,the cross nodes won’t show up unless you type “pdmode” and change value to 2 or 3. It is not 
necessary to show them up. You can snap the nodes by choose “Node” in “Object Snap” setting. If you don’t 
want to plot nodes, do not forgot to change pdmode value back to 0 before you plot.



COPY (cp): copies the selected objects from one place to another.

Select objects, click/type the base point and the second point that 
you want to copy objects to.

You can also copy+paste objects by selecting objects and 
right-clicking on them.  It will save objects in clipboard and al-
lows you to copy things from one fi le to another.  Select “copy 
with basepoint” to copy things between fi les at precise loca-
tions.

MIRROR (mi): mirrors objects along the line that you defi ne.

OFFSET(o): offsets objects to the distance you specify.

It will ask you whether you want to keep the original object or not 
after defi ning the mirror line.  type “y” for yes or “n” for no.

It will ask you the distance to offset objects fi rst.  you can 
specify it by typing the distance in or clicking two points on screen. 

After entering the distance, grab an object to offset and click on the 
side that you want to offset it to. 

You can offset an object multiple times in the same distance by 
repeating click. 

ERASE (e): erases the selected objects.  You can get the same effect by selecting objects and hitting Delete 
key.

Modify
There are two ways to modify

1. type full or short name in command line(increase effi ciency)

2. Icon: Home/Modify



MOVE (m): moves the selected objects from one place to another.

SCALE (sc): scale objects by the ratio you specify.

you can also scale objects by the relative distances using 
“Reference” points.

select objects, click/type a base point, then type “r” for Reference.

click the base point again, then click the second point to defi ne 
the original distance.  click the third point at where you wish the 
previous point to be after scaling objects.

In this way, it will scale the objects by the distance ratio of 
base point to the second point : base point to the third point.
Position of the base point needs to be constant.

select objects, click/type a base point and click/type the scale 
numerically.

TRIM (tr): trim objects along specifi ed objects.

Create objects that you want to use as trim edges.

Click on Trim tool, select the trim edges and hit 
enter, click on the objects to trim on the side that 
you want to erase.

You can trim multiple objects at once by using 
selection window or “fence” tool.

To use selection window, draw a window after 
selecting trim edges instead of directly clicking on 
objects to trim.

To use fence, type “f” after selecting trim edges 
and draw a line.  It will trim everything that the line 
crosses.

Select objects, click/type a base point and the second point that 
you want to move objects to.



EXTEND (ex): extend objects to reach specifi ed 
objects.

EXPLODE (x): break selected complex objects such as blocks and polylines down to lines and arcs.

Basic operation is similar to “trim”.  Select objects 
that you want to use as extend edges and hit enter, 
click on the objects that you want to extend.

You can also extend multiple objects at once by 
using selection window or “fence” tool.  For direc-
tions, please see “trim” section.

Useful options are:

Close: adds a line to close an open polyline.

Join: joins touching multiple polylines into one object
AutoCAD does not join vertexes when overlapped.  Make 
sure that the lines/arcs that you want to join are touch-
ing at an exact point.  If you are unsure, move one of the 
vertexes away and put it back together using “end point” 
snap.

Edit Vertex: modifi es control points.
After you select Edit Vertex, a little X appears at the end 
of a polyline.  It will move to the next control point every 
time you hit Enter.  You should navigate this X to the con-
trol point that you want to modify.

Adding a control point:
Navigate X to the control point right before the segment 
that you waht to add a point.  Type “i” to insert a vertex.
click where you want to add a new point. Hit Esc to exit 
the option.

Dividing a polyline at a control point:
Navigate X to the point that you want to divide.  Type “b” 
for break.  Type “g”.  Hit Esc to exit the option.

POLYLINE EDIT (pe): There are extensive options to edit polyline. Please pay attention to the command line 
for the available options and directions.



Spline: makes a selected polyline into B-spline curve.

Decurve: makes a curved polyline into lines.

BREAK (br): can make a cut in continuous line.

FILLET (fi llet): connects two objects with an arc that is tangent to 
the objects and has a specifi ed radius.

Choice 1) select an object by clicking where you want to start the 
break, specify the second point.

Choice 2) select an object, (f) for fi rst point, then click the second 
point.

When breaking a non-closed 
shape, the break occurs sim-
ply between two points.  When 
breaking a closed shape, the 
break occurs between two 
points counterclockwise.

Select radius, type #, select fi rst object, select second object.

You can fi llet:

- rectangle                                         - arcs

- circles
- ellipses
- different line types
etc

1

2

Select radius, type number,select fi rs object, and then the second 
one. If you don’t enter a number, the two lines will extend to join 
each other. 
You can fi llet:



most useful layer icons, especially when you have a lot of layers.

Please make a habit to name and manage your layers appropriately. Generally, it is better to put the same objects 
in the same layer. For example, you can name them “column”, “plant”, “building”, “road” and etc. If you manage your 
layers appropriately, you can lock/turn off/freeze all the layers except for the layers you are working on easily. In this 
way, you can select the objects you want easily.

right cross select all objects when all the layers are on right cross only select the blue fi sh when  other layers 
are locked

set the current layer to that of a selected object

turn off layer of a selected object

lock/unlock layer of a selected object

freeze the layer of selected objects
isolate unisolate

AutoCAD uses layer systems like Photoshop and SketchUp to 
organize a drawing.

Layer palette shows your current layer name and state. To access 
Layer Manager, click on the highlighted icon or type “layer” on the 
command 

Layers
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Layer Manager (layer)

indicates current layer

you can select layer colors by 
clicking here

changes layer line type (dotted, 
dashed etc.).  You have to 

load the line type in a different 
window to be able to use it in 

the drawing

changes line weight

turns on/off on the plot.  De-
fl oints layer cannot be plotted 

by default

makes a new layer

deletes the selected layer

makes the selected layer current

turns on/off the layer
turned-off layers become invisible on the 
screen but geometric information is still in the 
drawing

freezes/defreezes the layer
frozen layers are invisible and geometric 
information is unavailable

locked layers are visible but objects are not 
modifi able

locks/unlocks the layer

Rightclicking on the layer names gives you more options to 
manipulate layers such as fi lters and selections.

Pulling down the layer name 
on the layer palette also 
allows you some control on 
layers.
You can turn off/on, freeze/
defreeze and lock/unlock 
layer easily here. 



To adjust settings, right click on any snap/tracking tabs. A setting window will pop up.



Annotate

First, set up a new dimension style in Dimension Style Manager by clicking

Dimension Style Manager

choose new and set up a new style choose continue and then you can modify the settings.
The most important ones are: 

Modify dimension styles by choosing “modify”

Set the right style as current if there are several by choosing “set current”



set a new layer for dimension, then use the following tools.

Dimension

Dimension text override
If the dimension is not correct but it is hard to change the drawing, you can override the text by: select the 
dimension>right click>select “properties”> “Text”> “Text override”> type the number you want



BLOCK: groups and objectifi es selected lines as one entity.

Give a name easy to remember

Draw/move lines into layer 0 (or create block in new 
sheet, then later import the dwg fi le itself)
select them, block (b), pick base point by clicking 
pick point, later this point is used as insertion point.

Make sure convert to block is checked

Once the block is saved, you can insert from the 
saved location

You can modify a block in “block editor” 
Or explode, modify, then re-create the block.

or

BCOUNT: count the number of objects made by the same block. The computer will ask “select objects” after you 
type “bcount”. i.e. You can simplily count the number of the blocks named “Tree-6ft” by selecting any “Tree-6ft” 
block. If you type“all” and press “Enter” button, it will count all the blocks.  

Block



LIST (li): pops up a window with information of the 
selected geometry. 

List, select object. 

When you want to know the length of an arc or 
polyline, you should use either list of property.

Properties

You can change main properties. Auto CAD 2011 
adds “Transparency” feature here

Detailed properties list will pop up once right click

Detailed properties list will also pop up if you 
select a object/objects, right click and then select 
Properties. 

Properties can be overridden in this list 



QUICKSELECT (qselect): allows you to select by different property 
values.

This is a useful tool expecially when modifying a large 
amount of segments or small scale objects dispersed in a 
large area with particular property.

For example, you want to erase all blocks named “tree2” 
but not other tree blocks:

- Select “Entire drawing” on the top tab.

- Select “Block” on Object type tab.

- Select “Name” on Properties

- Change “Value” to “tree2” and click on OK button.

- It should bring you back to the drawing screen with all 
“tree2” blocks highlighted.  Hit Delete to erase them.

FLATTEN Z:  when you can’t measure the distance correctly, check the elevation or z-value in list or 
property. If that is a fi le that does not require to have 3 dimensional information, create 2D fi le by fl attening.  
The command is also useful to export sections and perspectives as 2D drawings.

Utilities

MEASURE 
distance(di): measure the distance between two points. click the fi rst point and then the second one. 



MATCH PROPERTY (matchprop): applies the properties of a se-
lected object to other objects (layer, color, line type...).

Matchprop, select the source object - the object you want to copy 
from, click the lines/objects that you want to paste the property.

Clipboard



zoom (z)

There are three ways to zoom:

1.The middle wheel on the mouse allows you to easily zoom in and out. 

2.type zoom(z in short) in command line.

(type “E” or “e” if use command line) allows you to zoom in/
out to the whole area that you have any objects

(type “W” or “w” if use command line) allows you to draw a 
window around the area you want to zoom in

(type “P” or “p” if use command line) go back to last zoom 
area

the same function as middle wheel on the mouse 

(type “A” or “a” if use command line) allows you to zoom out 
to the entire drawings are

(type “S” or “s” if use command line) allows you to zoom in/
out in certain scale

3. View/Extents

View

PAN(p) move the view



Insert reference

You can insert fi les in CAD, like image, other CAD drawing, excel form, pdf and etc.  

insert image

ATTACH: Click attach and choose 
the fi le you want to insert. Make sure 
you choose the right fi le format. 

You can trace images, like hand sketch, after you insert them in CAD.

Create new layer “image” and set it as the current layer. Insert the image in this layer. 

Keep “Specify on screen” checked 
unless you know the exact values of x 
and y coordinates. 

If you know the scale of the image, 
type value in Scale
i.e.1”=10’ drawing in the dwg with 
“inch”unit setting - 120 (10 x 12)
1”=200’drawing - 2400 (200 x 12) 

If you don’t know the scale of the 
image, guess and type an appropriate 
scale or check specify on-screen.



Select the image, and the adjust options will show up at the top.

If the image is over other lines that you want to see, adjust the draw order by selecting the image, right 
clicking Draw Order > Send to Back

For third point, normally just press enter.
Whether scale object based on alignment points is based on case by case. 

source point

source pointdestination point

destination point

ALIGN: Align the image to the existing 



SCALE(sc)

You can scale the image if you know a 
dimension of an object.

i.e. You know the length of the yellow edge is 
2. You can scale the entire image based on it. 

press enter after fi nishing selecting

type the new length

If you know the scale, type it here. If you 
know a dimension of an object in your image, 
type R

click one end of the edge and then the other 



When there is a fi le that you want to view in your drawing and are not 
intending to modify them, use external reference.

*Usually you are not supposed to modify fi les that you recieved from others.

* before you start modifying and xrefi ng any existing documents (especially from external 
sources), it is a good idea to clean the fi les by purge and audit.

PURGE (pu): Removes unused named items, such as block defi nitions 
and layers, from the drawing

purge, click “yes to all” (in most cases, you want to purge everything)

AUDIT (au): Evaluates the integrity of a drawing and corrects some errors

audit, (y) for fi xing errors automaticlaly

Attach vs overlay: generally choose overlay, unless you are submitting 
the fi les themselves to clients.

Attach = the attached xref will be carried to the next tier of fi les 
i.e. if you xref a fi le that has attached xref, you will see both xrefs

Overlay = the overlaid xref will not be displayed in the next tier of fi les. 

* it is commonly thought that the information itself is not carried by overlay. However, that 
is not always true. Sometimes overlaid information is carried as ghost and start cross refer-
encing each other. This could cause slowing down the fi le and possible damage.

insert dwg.fi le- external reference (xref)

less useful at school but very important when you collaborate with other people in the offi ce



When you want to modify an xref fi le through the working fi le:
- refedit (or double click), save the change.

  This option is not the most stable way to edit an xref.   Unless you want to do a few very simple  
  things, open the original drawing, edit and save it, then reload the xref in your working drawing.

When you want to copy objects from an xref drawing to your current drawing:
- Nested object copy (ncopy), select objects, enter, click the paste destination.

 * there are limits to the number of objects to select at a time

Browse the fi le, choose attach or overlay, choose insertion point , scale, 
rotation,  in the case, it is a plan that has same ucs (origin 0,0) and drawn 
to full (1:1) scale, leave boxes unchecked. 

If you are xrefi ng a fi le that is not created with same ucs, either pick the 
insertion point, or move the fi le and align after you attach it.

* If you do not see anything, zoom extend and fi nd out their location. 
When it does not match, make sure your ucs is “world” 

xreference manager

Modify xreference

Unload vs Detach: Detaching delete the xref. Unloading just makes xref disappear from the screen. 

right click



Now, let’s practice on Carr’s hill plan.
Open Carr’s Hill Base fi le and zoom into Payton hall parking lot area.

Let’s create a new layer called “Section” and make the layer current

<click layer manager or (layer), click new layer icon, name the layer>

* If you are creating a section/elevation that includes multiple objects, you may want to 
create a layer for each object and color code them for your reference.
i.e. structure layer = red, trellis layer = blue, tree layer = green

Draw a line close to mid point of the football fi eld, perpendicular to 
the street.
<line (L), click the fi rst point, perpendicular (per), click the other 
side of the street>

Extend the line 200’ (2400”) to the both sides.

We are going to cut a simple section, ground line and a structure.

The basic idea is same as hand drawing. 
- Make a section cut
- Extend the height

For example, on the right drawing, there is a 100’ tall tower on the 
top of a mound. There are 10’ contour lines. 

Draw a section cut line. 

Make lines from the intersection of the section cut and each 
contour line & structure line by typing the numbers (this drawing 
unit is in ichi = # should be multiplied by 12). 

You can either connect lines where the reference lines are, or 
make a copy of lines, move them to the clear area, then connect 
them.



When the plan is angled like this case, you can either: 

1) Rotate UCS (User Coordination System) accoding to the section line.

or

2) Make the section cut as is and rotate the reference lines later.
(This works when you can’t change UCS for some reason, and the section is short and simple)

After completing the section, you should change UCS back to default (World), especially when sharing a 
fi le with someone else.

1)
Rotating the view

We are going to rotate the view based on the section 
line. We use UCS command.

There are 2 steps

1. Creating new UCS
<type (UCS), then (e) to defi ne XY cordinatnts by an 
element you want to align the X axis to, in this case 
your section line>

2. Changing the view according to the new UCS
< type (plan), choose current ucs or just hit Enter>

You can create section reference lines using ortho
snap, you can save the fi le specifi cly for section or 
you can change the UCS back to “world” when you 
are done.



2)
Now we can try the way without changing the UCS.

There are multiple ways to do this. Drawing perpendicular 
reference lines to the section cut is one way.

To create perpendicular lines easily, turn the polar tracking snap 
on and open the setting by right clicking on it.

In “Polar Tracking” tab, “Polar Angle Measurement” section, click 
on “Relative to last segment”.  The guideline perpendicular to the 
section cut will appear.

Draw perpendicular lines from the section cut intersections. 
When OSNAP intersection does not appear where it looks 2 lines 
intersect, try Apparent Intersection. This is because some lines 
have z values (elevation) and 2 lines are not exactly intersecting. 
Apparent Intersection selects intersected objects on the plan view.

<line (L), click Apparent Intersection or OSNAP apparent 
intersection on, click the fi rst point and start a perpendicular line, 
move the cursor on the top of the second line, type in the height of 
the reference line>

Extend the lines to the appropriate height. 

In this example, we do not have contour lines labeled. Let’s check 
the elevation in the property box and use that number.

Grab the end point at the section cut. Move it up and fi nd the point 
that says extension. Where it shows “extension”, lock the point and 
type #s. When the “extension” does not show up, it usually helps to 
put the cursor over the original endpoint.

For fence, add 40” on the top of the elevation, for the structure add 
240” on the top of elevation.



When you are done with making lines, let’s copy them and 
paste where there are no other lines.

In order to select only the section line, you can use the 
command layer isolate (layiso).

<type (layiso) or format/layers/layer isolate, select the lies on 
the layers that you want to isolate, enter>

Now you can only select the lines/objects on the isolated 
layers. You can change the other layers off/freezed/locked.

<select the lines, copy, paste above>

Now rotate the lines. 

<Turn on Ortho, darw a horizontal reference line from one end 
of section cut line, select all the section related lines except 
the reference line, (ro) for rotate, base point is the shared 
endpoint, (r) for reference, click the shared endpoint, then 
the other end of the line you want to move, click the the other 
endpoint of the reference line>

Now you connect the lines.

Xclip:

You can “clip” xrefs to display only parts of them.  It is useful 
especially when you want to make a partial section so that 
your section is not too far away from the cut line on the plan.

Type “xclip” and enter

Click on the object on xref that you want to clip then 
enter

Type “n” for New Boundary

Type “s” and select the clipping boundary if you  
already have it drawn in CAD

OR

Type “r” for drawing a rectangle clipping boundary 
or “p” for polygonal



Create a new layer and give a clear name like “take off.”

Make polygons of the areas that you want to know. 

If it is one connected polygon area, you can simply select the 
polygon and “list.”

If there are multiple polygons, you can use the command “area.”

“a” for add, “o” for object, select 
polygons that you want to sum up.

Total area is shown in the com-
mand line.
You can subtract the areas by 
typing “s” and select shapes to 
subtract.

When you select an open object, CAD will automatically 
bound the area connecting the start and end points with a 
straight line.

AREA (aa)

Area calculation
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You can plot either from the model space and layout space.

Plotting from the model space is used for quick not-to-scale refer-
ence printing or in-house basemaps.

Plotting from model space:

While you are in the model space, go to print, the window on the 
right pops up. 

Choose paper size.

Select “Window” and draw a rectangle around where you want to 
plot.

Check “Fit to paper” if the scale 
is not important. If you want to 
print in scale, put the appropriate 
number in the box.
i.e. 1” = 40’, 40 x 12 = 480
       you type 480

By clicking the arrow on the bottom right, you get more options.

For plot style, you should select appropriate pen settings for the project. 
The CAD default is “acad”.

CTB fi les translate the line colors on your drawing to line 
widths, types and tones using index color system.  Firms 
often have their own standard settings, typically color 1 
(red) being the thinnest line and lines becomes wider as 
the color number goes up.

You can also create or edit the CTB fi le by clicking the pen 
symbol on the right top.

Some machines at A-school do not load CTB fi les.  
If that is the case and you want a monotone print, 
create your own CTB fi le or change all object colors 
to monotone and assign line width manually by 
individual object or layer in your drawing.

Plot
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Plotting from layout:

Layout: You can change model space and layout space by clicking 
the tab on the bottom of display. 

Layout is a sheet setting. Layout has 2 different spaces; 
1) model space, 2) paper space
You can check which space you are in and change the status by 
clicking the tab on the fat bottom.

Make a new layout

insert>layout>new
or
right click the bottom tab “layout 1”

Name the new layout “11x17” - because that will be our page size

Go to the layout “11x17”

Open the “page setup manager”

Select “11x17” and click modify

Select appropriate printer and modify the propertoes 
by click the property button and go into property 
windows, if necessary. 

For this exercise, choose Adobe PDF.

Choose Tabloid/11x17

Make sure that the plot scale is correct. 
If your dwg units are in inch, the default is right 
1”=1unit

If your dwg units are in feet, that would be
12 inches = 1 unit

If your dwg units are in meter, you should choose 
millimeter instead of inch, then type

1000 millimeter = 1 unit

In metric CAD fi le, layout/plot space is alwasy in mil-
limeter. Model space units vary.

Same as plotting from the 
model space. Select “acad” 
for this exercise.

Check “scale lineweight” 
box when you are plotting in 
smaller scale or size, so that 
the lines are not too thick.



Layout uses a frame called “viewport” to display the model space. 
A sheet can have multiple viewports and you can turn on/off certain 
layers per viewport.

Let’s delete this existing viewport.

Create a layer called “mview” in the layer manager.

We want to create a new viewport.

View>Viewports>New Viewport
<(mv) for mview, (f) for fi t, enter>

Fit automatically gives you the maximum fi t for the sheet. You can 
adjust the rectabgle afterwords too. If you want to be able to create 
non rectalinear shape, choose (p) for polygonal and start drawing 
the box manually.

By double clicking inside of viewport, you can go into the model 
space and modify the objects in the model space. Double clicking 
outside of the viewport or clicking the tab on the bottom put you 
back into the paper space.

Scale:

To scale the model to plot, you want to know approximate scale that 
you want to print. 

In this case, I want to plot 1”=200’ (200 x 12 = 2400”)

Double click and go into the model space through the viewport,
<zoom (z), type (1/2400xp)>

* “xp” refers to “in paper space”

Adjust the location (when you do this, do not touch the middle wheel 
and change the scale...)

Get out to the paper space by double clicking outside of the viewport 
and plot!

* You can always preview too. If the print does not come out with the right orientation, 
although the preview is correct. Usually it is the property setting of the printer, rather 
than the page set up of the CAD.



In ArcMap (version 9x or up)

Open Arc Toolbox

Select Export to CAD

Conversion Tool > To CAD > Export to CAD
* When you can’t fi nd the tool you need, you can keyword 
search by clicking the search tab on the bottom of toolbox 
window. When you see the appropriate choice, you can either 
double click to open the tool or click “locate” to see where the 
tool is in the original view, “favorite” tab. 

Import & export
import from GIS to CAD



Choose the layers that you want to export from 
the pull down bar on the top. 

Select appropriate version of DWG 

Specify the location and name of the fi le
(may require you to type the extension “.dwg”

Press OK

REMEMBER, you normally have to rescale 
the drawing x12 because the unit of GIS data 
is usually in feet, but the default unit of CAD is 
usually in Inch.

Re-Scaling the drawing

(Scale) > (Select) >(All) > enter > specify appro-
priate  base point by clicking the point or typing 
the value such as (0,0) > (12) for scale factor.

Zoom extent to see the whole drawing.

* Show Help button offers brief explanations on the right.

Confi rm completion and open the exported dwg fi le 
in AutoCAD.

In AutoCAD



export from CAD to Sketch Up

preparation
Turn off all unnecessary layers such as dimensions, furniture,etc. 
Save a new fi le to import into SketchUp. Don’t use your original CAD fi les
You will need to know the CAD drawing units: inches, feet or meter.
If the objects in the drawing don’t need to have Z value, fl atten all by using 
“fl atten” command incase some objects has wrong Z value. 

import
File>Import>choose dwg. fi le,click “Options”

Check the three boxes and match the Units with your CAD drawing.

Check a object’s length you know by “type measure tool” to make sure the scale is correct.

If your CAD version is too high to be compatible with your Sketch Up, you wont’ be able to import it to Sketch Up 
successfully. If so, you need to save the CAD drawing as a lower version drawing. 

wrong Z value



There are two ways to use the CAD drawing.

1. Use the CAD drawing as a reference
select all the layers except for Layer0> click “-” button> check “move contents to default layer”>set up a new layer 
by “+” button>put the drawing into the new layer

2. Create surface in the CAD drawing’s layers, especially when the shape is hard to trace in Sketch Up

You need to close the shape in CAD.It is better to make the outline as a Polyline by command “pedit(pe)”. In this 
way, you can double click to enter the group and trace one edge in order to make the surface. 

This method is useful when you only import one layer or a few layers. So you don’t need to trace them again.If 
you import a lot of layers at one time, using Method 1 will avoid to mass the Sketch up drawing up.


